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 INTRODUCTION 

1.1 Overview 

The objective of the Integrated Photogrammetric Control Environment (IPCE) is to incorporate all aspects 

of the photogrammetric control process within a single interactive and user friendly environment. By 

simplifying data management, providing statistical and 2D/3D graphical data analysis tools, and automating 

processes and analysis, we improve the efficiency and cost-effectiveness of the process. This in turn is 

likely to improve the quality of products such as Digital Image Mosaics and Digital Terrain Models, and 

geologic maps using them as basemaps. 

1.2 Points of Contact 
 

1.2.1 Information 

 

To be completed. Provide a list of the points of organizational contact (POCs) that may be needed by the 

document user for informational and troubleshooting purposes.  Include type of contact, contact name, 

department, telephone number, and e-mail address (if applicable).  Points of contact may include, but are 

not limited to, help desk POC, development/maintenance POC, and operations POC. 

1.2.2 Help Desk 

 

To report issues and ask questions, visit the Astrogeology Support and Issue Tracking System at the link 

below. 

 

https://isis.astrogeology.usgs.gov/fixit 

1.3 Organization of the Manual 
 

To be completed 
 

2.0 – User Interface - What’s in the menus, Project Tree and its corresponding nodes. 

3.0 – Cnet Editor View - Overview of editing control nets using tables and filter options. 

4.0 – Cube DN View - How to display image DN data as well as the available tools for analyzing the data. 

5.0 – Footprint View - How to display polygon(s) of image borders in order to show image locations relative   

to one another.  

6.0 – Control Point Editor - Overview of the tools available in control point editor. 

7.0 – Control Net Health Monitor - What to expect from the control net health monitor as well as how to 

use it to keep nets healthy. 

8.0 – Image Measurements – This section will expand on using the control point editor to add and remove 

points to control networks. 

9.0 – Bundle Adjustment - This will be a guide on how to use ipce for bundle adjusting and controlling 

images. 

10.0 – Known Issues - This program is still under construction and known issues will be listed here. 

 

https://isis.astrogeology.usgs.gov/fixit
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1.4 Acronyms and Abbreviations 
 

Provide a list of the acronyms and abbreviations used in this document and the meaning of each. 

 USGS – United States Geological Survey 

 ASC – Astrogeology Science Center 

 ISIS – Integrated Software for Imagers and Spectrometers 

 IPCE – Integrated Photogrammetric Control Environment 

1.5 Installation and System Information  

1.5.1 Installing ISIS3 

Detailed instructions for downloading and installing ISIS3are provided at the link below.  

  

https://ISIS3.astrogeology.usgs.gov/documents/InstallGuide/index.html 

1.5.2 System Requirements 

System requirements are provided in the installation link in Section 2.0.1 above and repeated below for 

quick reference. 

 

Operating System Requirements Minimum Hardware Requirements 

ISIS DOES NOT RUN ON MS WINDOWS. 
Supported UNIX variants include… 

 

 Ubuntu  64-bit (x86) processors 

 RHEL  2 GB memory 

 Debian  10-180 GB disk space for ISIS installation 

 Fedora  10 GB (to many TB) for processing images 

 Mac OSX  Quality graphics card 

1.6 Data Requirements  
In the future IPCE will be able to ingest images into ISIS3 cube format. As of now please take these steps 

with images to get images into cube format so IPCE can further process them. 

1.6.1 ISIS3 Cubes 

In the future IPCE will be able to ingest images into ISIS3 cube format. Currently however, images must 

already be in the ISIS3 cube format to import into IPCE. Further, they must be in Level1 space (i.e. not 

projected) and must contain SPICE information (via spiceinit). If footprintinit has not been run on the cubes, 

a footprint will be created upon import (which can be time consuming). 

1.6.2  Control Networks 

Currently control networks can be edited but not created within IPCE. Use ISIS3 applications such as 

autoseed, seedgrid, findfeatures, and pointreg to create a control network to import into IPCE.  

  

 

https://isis.astrogeology.usgs.gov/documents/InstallGuide/index.html
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 USER INTERFACE 
 

The IPCE user interface (UI) (Figure 1) consists of three major components, 1) the project tree on the left; 

2) the work space to the right of the tree; and 3) the warnings and history windows at the bottom of the 

interface. The project tree contains all project data including imported data and generated results (e.g. from 

 

 

Figure 1:IPCE user interface. Top: interface display on startup with project tree view on the left and working space on the right. 

Bottom: example project with image cube view displayed in the working space. 

 

Project 

Tree 

Work 

Space 

Warnings 

& History 
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the bundle adjustment). The project tree is described in Section 3.3 below. In the working space all imported 

data can be displayed and manipulated (e.g. Figure 1, bottom).  

2.1 Main Menu 

2.1.1 File Menu 

 

From the File menu (Figure 2) one can open, save, and close projects; import data; and exit IPCE. 

2.1.1.1 Open Project  

An existing project can be opened from the file menu shown below and clicking open project or a file can 

be opened from the main menu by 

clicking on the blue file with the green 

plus sign in the top right corner. Open 

Project opens a “Select Project 

Directory” dialog ipce projects are 

stored as directories. A directory will be 

selected and then click ok.  If there is an 

existing file in the current directory 

using command line >> ipce (Project 

Name)  

This will open IPCE and load the 

project to its last saved point. 

2.1.1.2 Save Project 

This saves the state of the current 

project including any changes made to 

control networks. The first time a 

project is saved, the user is prompted 

with a dialog to choose a project 

location. 

2.1.1.3 Save Project As 

The user is prompted with a dialog to 

choose a new project location. 

2.1.1.4 Import 

Import options are as below  (Figure 2, 

center). The user is prompted with a 

dialog to choose the item to import. 

 

 Import Control Networks 

 Import Images 

 Import Shape Models 

 Import Templates 

2.1.1.5 Export 

Control networks and images can be 

exported from the IPCE project (Figure 

 

 

 
Figure 2: File menu (top). Import options (center) and export options (bottom). 
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2, center). Note that if there are no images or control networks in the current project these options will be 

unavailable. The user is prompted with a dialog to choose the export location. 

2.1.1.6 Close Project 

This closes the current project. IPCE remains open. 

2.1.1.7 Recent Projects  

Up to five recently opened projects will appear in 

chronological order under the Recent Projects submenu. 

These can be re-opened directly by selecting them from 

the submenu. 

2.1.1.8  Exit  

Exit closes the program. The user is prompted to save 

the current project if there are unsaved modifications. 

2.1.2 Project Menu 

The Project menu (Figure 3, top) contains options to 

rename the current project and to perform a bundle 

adjustment (Section 4) Note that a project can also be 

renamed by right clicking the project name on the 

project tree. 

2.1.3 Edit Menu 

This menu contains Undo and Redo commands (Figure 

3).  

2.1.4 View Menu 

From the View menu (Figure 3) the user can Tab or Tile 

existing views. The default view mode is to open new 

views as separate tabs in the main workspace. Each view 

can be activated by clicking the corresponding tab 

(Figure 4, top). If Tile Views is selected the display will 

look like (Figure 4, bottom). All views in IPCE can be 

undocked by clicking and dragging the view from the 

upper portion where the view title is located. The views 

can then again be redocked by clicking the box with two 

squares  in the upper right corner. Views can be 

tabbed tiled and undocked all the same time.  

When ipce is in full screen and the views are tabbed clicking the detach view button  will detach the 

view while keeping it in the same size and location making it appear as nothing has happened. This problem 

only exists while in full screen.  

 

 

 

 

 

 
Figure 3: From top to bottom: Project, Edit, View, Settings, 

and Help menus. 
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Figure 4: Top - shows the default view configuration in which each view opened is in its own tab. Bottom - shows the results of 

clicking Tile Views each is now visible in the workspace. 
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2.1.5 Settings Menu 

To be completed. What’s going on with this 

stuff, how to document? 

2.1.6 Help Menu 

Currently there is only one option in the Help 

menu. Selecting the 

 option 

(Figure 5, top) will change the cursor to 

either or . When hovering over an item 

that has associated Help content the cursor 

changes to . When this item is then 

clicked, a popup dialog with the help content 

appears (e.g. Figure 5, bottom). If there is no 

help content available, the cursor changes to 

.  

2.2 Project Tree View 
The project tree contains all imported data as 

well as results from bundle adjustments. 

Within the project tree, under the top level Project node, are eight distinct nodes including Control 

Networks, Images, Shapes, Target Body, Sensors, Spacecraft, Templates and Results. Each node is 

described in detail below.  

2.2.1 Project Node 

The top level project node contains all eight nodes. When opening a new project this node will be named 

Project (Figure 6, left) until the project is saved. At that point this node is renamed to the project name (Figure 

6, right). 

2.2.2 Control Networks Node 

The Control Networks Node contains all imported control networks. Multiple networks can be imported at 

the same time. All control networks imported at the same time appear under a single sub-node below the 

 
 

 
Figure 5: What's This option on Help Menu (top).Example of popup help 

content (bottom). 

  
Figure 6: Control Network import with multiple control nets in the same node (left).  Menu displayed when right-

clicking an image import node (right).  
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Control Networks node (Figure 6, left). The sub-nodes for each import are named e.g. controlNetworks1, 

controlNetworks2, etc. 

2.2.3 Images Node 

Under the Images node, consecutive imports are labeled 

Import1, Import2, etc. After import these can be renamed by 

double clicking the import name and typing in the desired name 

and pressing enter. To see the list of images that make up an 

import, expand the import node by clicking the arrow next to it. 

Right-clicking on an import node or a selection of images 

displays a popup context menu (Figure 7). This menu contains 

options to 1) Set Active Image List (Section 2.2.31); 2) Display 

Images in the Cube DN View (Section 2.4), 3) View Footprints 

(Section 2.5); and 4) Export Images (Section 2.1.1.5). 

2.2.3.1 The Active Image List 

If there is only one image list in the project it will default to the 

active image list and the text on the import name will turn green. 

If there are multiple imports in a project, then after right clicking 

an import the option to set that import to the active image list 

will appear. It can be seen in Figure 7 that import2 is set as the 

active image list and the text is green. Now that there are two 

imports in the project the option to set the non-active image list 

to the active image list is now available. 

 

2.2.4 Shapes Node 

The shape node will contain images that 

can be referenced by control points that 

have a point type that is controlled or fixed. 

When a new control point is created or 

edited there is an option to change the point 

type and when that is changed to either 

controlled or fixed a new option will 

appear labeled ground source. The options 

to select from in ground source will be any 

imported shape files in a drop-down menu. 

Currently the shape files are 2.5D DEMs 

(digital Elevation Models) located in 

/usgs/cpkgs/isis3/data/base/dems/. In the 

future this will include true 3D objects (e.g. 

TINs, NAIF plate models, etc.). 

 

Ground Source- Will be an image cube can used as seen in (Figure 9)  

 
Figure 7: This shows import2 as the active image 

list and now import1 has the option the be set as 

the active image list If there is only one import in 

the project by defualt it is the active image list and 

Set Active Image List will not be an option.  

 
Figure 8: Project tree after a shape model is imported. 
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Radius source – This will be a digital elevation model 

(DEM) and with latitude and longitude from the ground 

source file an accurate radius can be obtained from the 

Z coordinate on the DEM. 

 

 

2.2.5 Target Body Node, Sensors Node, 
Spacecraft Node 

This is auto 

populated based on 

the data contained 

inside the cube 

labels (Figure 10). For every different target body sensor and spacecraft 

there will be one generated in the corresponding nodes. This image 

shows different nodes based off of data contained within the three image 

imports. If an individual node is right clicked on there is a get info option 

which will pull up a page of useful info on the given item.  

 In the current version Sensors displays (spacecraft/Sensor) ex 

Apollo/Metric and spacecraft is left empty. 

2.2.6 Templates Node 

To be completed.  

After templates are imported they can be right clicked on and then select edit template to edit. In (Figure 

13) the editing area can be seen after edits are complete click Save Changes to keep edits there is also a 

Save Changes As option. The editor can be closed or undocked with the small x or square button in the top 

right corner.  

2.2.6.1 Map Templates 

Map templates can be found at /usgs/cpkgs/isis3/data/base/templates/maps.  Map templates are used for 

projecting flat images to their appropriate body shape and defining their location as well as resolution of 

the images. Templates are used in isis3 programs such as cam2map and map2map if no template is 

provided a list of where default values will come from can be seen below Figure 11.  

 

In IPCE, the maps node is present to have multiple map templates imported in order to change quickly 

between different options to obtain the desired results. (currently templates can be imported and saved but 

not used unless reloaded into the footprint view map tool)  

 

 
Figure 9 Image showing the use of a shape model when 

creating a new point in the control point editor 

 
Figure 10 Sensors/Spacecraft populated 

in the project tree from cube lablel 

 
Figure 11: Default  parameters for map templates 
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2.2.6.2 Registration Templates 

Registration templates can be found at 

/usgs/cpkgs/isis3/data/base/templates/autoreg. Automatic 

registration is the attempt to match a pattern in an image 

cube. Pattern matching has many different purposes.  

 

Examples: 

 

1. Register an entire image to a second image. The 

registration of an image is performed by moving (rubber-

sheet) the pixels to output pixel locations that result in pattern 

matching directly to a second 'fixed' or 'truth' image. (coreg). 

2. Relative cartographic registration between a number of 

overlapping images. Pattern matching is used to build a 

control point network across a number of overlapping images 

for solving and adjusting the camera pointing that are then 

applied to map project the images. (pointreg, jigsaw). 

3. Find and record the pixel location(s) of a camera reference 

mark (e.g., Vidicon reseau mark) across an image (findrx). 

 

Templates are used in ipce in the control point editor tool for 

subpixel registration more information will be found in 

IMAGE MEASUREMENT. 

2.2.7 Results Node 

Bundle adjustment (BA) solution information appears under 

the Results node of the project tree (Figure 14). Each 

individual BA run appears on the tree under a child node 

labeled by default with the run time. Note that this label can 

be edited by double-clicking the label and typing directly in the 

resulting edit box. Information displayed for each BA run includes… 

 

 Settings: BA settings are saved (currently can’t be displayed).  

 Output Control Network: Right clicking on the adjusted output 

control network displays a popup context menu with options to 1) set 

as active control network; 2) view/edit the network in the Cnet Editor 

View (Section 2.3); and 3) export.  

 Statistics: A bundle summary and statistics for image measures, 

images, and control points are available under this node. Each can be 

displayed by right-clicking and choosing View… from the resulting 

popup menu. The summary is displayed as text and the statistics in 

tables.  

 Images: This node contains detached image cube labels with 

SPICE as updated from the BA. Right-clicking on an individual 

image or the images immediate parent node displays a popup menu 

with options to 1) Display Images…; 2) View Footprints…; or 3) 

Export Images…. Displaying updated images or footprints utilizes 

the original DN data with the updated SPICE. 

 Note footprint view will not be available until the project is saved 

as or saved closed and reopened. 

 
Figure 12: Equirectangular map template example 

 

Figure 13: Template editor 



2 USER INTERFACE 

 

 IPCE User’s Manual  Page 2-9 

2.3 Cnet Editor View 
To be completed. Cnet Editor View) is used to view 

control networks and to edit the active control net. The 

main views in Cnet Editor are: 

2.3.1 Control Point Table 

A table that contains a list of all control points in the 

control net. This table will update when a filter is 

applied. The list can be sorted by clicking (^, down) in 

the tip of the desired column. The editable tabs in this 

table are:  

 

By double clicking in any of the editable cells the option 

to type in a value or to select an option from a drop 

down menu will be given. Once a cell has been changed 

the cell can be right clicked on and there is an option to 

copy to all cells.  

 

2.3.2 Control Measure Table 

A table that contains a list of all the control measures in 

the control net. This table also updates when a filter is 

applied. The list can be sorted by clicking (^, down) in 

the tip of the desired column. The editable tabs in this 

table are: 

 

By double clicking in any of the editable cells the option 

to type in a value or to select an option from a drop 

down menu will be given. Once a cell has been changed 

the cell can be right clicked on and there is an option to 

copy to all cells.  

2.3.3 Point, Serial, and Connection Views  

These three views occupy the same working space and it is necessary to click on the tab of the desired view.  

Point View- this will display a list of all the control points with a drop down menu on each that contains a 

list of the images that make up that control point. This list will update when a filter is applied. No editing 

can be done from this view.  

Serial View- This view contains a list of cubes and each cube has a drop down menu which contains a list 

of all the control points that exist in that cube.  

Connection View- This view contains a list of cubes and each cube has a drop down menu which contains 

a list of other cubes that are connected to it.  (I am not sure if this information is correct) 

2.3.4 Filtering Views 

Filter Points and measures, Filter Images and Points, Filter Connections 

These three views share the same work space and it is necessary to click on the desired tab. Each tab will 

filter different corresponding views. 

Filter Points and Measures- This filter will be applied to the Control Point Table, Control Measure Table 

and Point View. 

Filter Images and Points- This filter will be applied only to the Serial View 

 
Figure 14: Bundle adjustment solution statistics under the 

Results node. Two separate BA results are shown, under the 

sub-nodes 2018-03-27T15:48:22 and 2018-03-27T15:48:4. 
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Filter Connections- There is no 

functionality in this filter yet but it 

would be applied to the Connection 

View.  

 

Filter Options 

To add a filter to any of the three tabs 

click on the box that contains the green 

+. Once this is clicked done another 

box containing a red × will appear with 

a drop down menu next to it. Once a 

filter is selected more options will 

appear based on the type of filter 

selected the main types of filtering 

options are. 

 Inclusive exclusive 

 <=, >=, Will have a text entry box to input a value for comparison 

 Points, Measures, Min Count for Points This option will let you choose to filter between Control 

Points and Control Measures if the control point option is on then the Min Count for Control Points 

will be available if not this option is not available.  

 

Multiple filters can be applied by clicking on another green + there will then be an option to link these 

filters with AND, OR logic statements. It can be seen in Figure 15 that it is possible to have multiple lines 

of filters each will be contained in a box and logic statements only apply to the filters in its box but if 

multiple boxes are open then another logic statement to link them will be at the top of all the boxes.  

There will be a line of text above the filter options that will use words to say what the logical statements 

are doing. Check this line of text to ensure it will give the desired results.  

 
Figure 15: This shows how filters are chained together with logical statements.  

 
Figure 16: Tables in cneteditor view. 

Control Point Table 

Control Measure Table 

Filter Options 
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2.4 Cube DN View 
 

Cube DN View will display any 

imported images as well as control 

networks if there are any present. The 

Cube DN View has a toolbox 

associated with it that will be located 

on the right side of the IPCE program. 

Under the view menu there are options 

to link images, tile the image view, 

moving images and zooming on 

images.  

 

 

 

 

 

 

Display Images (brings up qview)-Tools- (short cuts) 

 

Descriptions of each tool can be seen by using the (What’s This Tool) under Help or on the toolbar. 

 

Right 

-----------------

 Control point editor (T)  

 Band Selection (B) 

 Zoom (Z) 

 Pan (P) 

 Stretch (S) 

 Find (F) 

 Image Edit (E) 

 Measure (M) 

 Sun Shadow (U) 

 Nomenclature (N) 

 Spatial Plot Tool 

 Spectral Plot Tool 

 Scatter Plot 

 Histogram (H) 

 Statistics  

 Stereo 

Upper left 

------------- 

 Blink 

 Tracking 

 Link Viewports 

 Special Pixel Tool 

 What’s This 

 

 
Figure 17: Cube DN View after  selecting Display Images from the Project Tree. 
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2.5 Footprint View 
 

To be completed. Footprint view 

allows the user to visualize cubes in 

relation to each other by displaying the 

cube outline. By doing this the overlap 

of cubes can be seen as well as how the 

control network is dispersed among 

overlapping regions Figure 18.  

 

 

 

 

 

 

 

 

Tools in the footprint view 

 Select (s) - allows to click on images or files and select  

 Zoom (z) - zoom in, zoom out, fit to screen 

 Pan (p) - allows images to be clicked and dragged 

 Control net (c) - Enables the editing of control points  

 Show Area (a) - draws a box on footprints, input lat/long and box size 

 Find (f) - input a lat/long and go to that point or click on images to get lat/long of that point 

 Grid (g) - will display a grid on the footprint view  

 Quick Load Map (lightning bolt) – Load in map files for projections and lat/long setup 

 

 

Right Click on Image in Footprint will give the following options.  

------------------------------- 

Change Transparency 

Change Color 

Randomize color 

Show Label 

Show Unfilled 

Show Cube Data 

Hide Outline 

---------------------------- 

Bring to Front 

Bring Forward 

Send to Back 

Send Backward 

---------------------------- 

Zoom Fit 

---------------------------- 

Display Images… 

View Footprints... 

Delete images from project… 

Export Images… 

----------------------------- 

Close Cube 

 
Figure 18: Footprint View with the active contol network display which is done 

by clicking the cneteditor tool on the toolbar on the right side. 
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2.6 Control Point Editor 
View 

2.6.1 Loading a Control 
Point 

The Control Point Editor View is used 

to visually manipulate control 

measures. Similar to the ISIS3 qnet 

application, this is accessible from the 

Footprint or Cube Display views when 

the control point editor tool is selected 

. It is also accessible from the Cnet 

Editor View by right-clicking on a 

control point and selecting “Edit 

Control Point” from the resulting 

context menu. 

 

Control Measures are drawn on 

displayed cubes or footprints with the 

following colors: 

 

 green “+” control point 

 magenta “+” ground point 

 yellow “+” ignore point 

 red “+” current edit point 

 

When the control point editor tool is 

selected, the mouse buttons have the 

following functions on the cube 

display view and the footprint view: 

 Left Button: Modify the closes 

control point 

 Middle Button: Delete the closest control point 

 Right Button: Create new control point 

 

Note: when creating a new control point using the right mouse button, the new point will not be added to 

the control net until the “Save Point” button is selected. The control point will not appear on the Cube DN 

or Footprint views until it is saved to the control net. 

2.6.2 Editing a Control Point 

 

This window displays information about the control point and two control measures.  Initially the measures 

displayed will be the "Reference" cube on the left and the next cube in the control point on the right. The 

measures displayed are chosen from the combo-boxes under the labels "Left Measure" and "Right 

Measure.” The previous or next right measure is selected with the PageUp and PageDown shortcut keys, 

respectively. 

 

 
Figure 19: Control Point Editor view 
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2.6.2.1 Control Point Information 

 Point ID 

 Number of Measures 

 Ground Source: For fixed or constrained control points, allows choice of any imported ground 

source to be used to calculated the Apriori Latitude and Apriori Longitude. 

 Radius Source: For fixed or constrained control points, allows choice of imported dems to be used 

to calculate the Apriori Radius. 

 Apriori Latitude 

 Apriori Longitude 

 Apriori Radius 

 Edit Lock Point:  Allows the control point to be locked which disallows any changes to  

 Ignore Point: Any ignored control point is not included in a bundle adjustment. 

 Point Type: Change the point type to Free, Constrained or Fixed. 

2.6.2.2 Changing Measure Locations 

The measure location can be adjusted by: 

 Move the cursor location under the crosshair by clicking the left mouse button 

 Move 1 pixel at a time by using arrow keys on the keyboard 

 Move 1 pixel at a time by using arrow buttons above the view 

2.6.2.3 Other Point Editor Functions 

Along the right side of the measure display: 

 Geom: Geometrically match the right view to the left view 

 Rotate: Rotate the right view using either the dial or entering degrees 

 Show control points: Draw crosshairs at all control point locations visible within the view 

 Show crosshair: Show a red crosshair across the entire view 

 Circle: Draw circle which may help center measure on a crater 

 

Below the left measure view: 

 Blink controls: Blink the left and right view in the left view window using the "Blink Start" button 

(with play icon) and "Blink Stop" button (with stop icon). Both arrow keys above the right view 

and the keyboard arrow keys may be used to move the right view while blinking. 

 Find: Center the right view so that the same latitude / longitude is under the crosshair as the left 

view. Shortcut: F 

 

Below the right measure view: 

 Register: Sub-pixel register the right view to the left view. Shortcut: R 

 Undo Registration: Undo the sub-pixel registration. Shortcut: U 

 Save Measures: Save the control measure under the right view to the edit control point. Shortcut: 

M 

 Advanced Blink: Note: This is a prototype. This allows a more advanced blinking functionality. 

All control measures in this point will be listed. Currently this list contains the full file name 

including path so scrollbars allow the entire file name to be viewed. Select any number of files in 

this list that you want to blink. This list can also be re-ordered through drag and drop to sort the 

blink order. The blinking will happen in the right measure view. 

 

Along the bottom: 

 Reload Point: Discard any edits that have not been saved and re-load the current edit control point. 
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 Save Point: Save the edit control point to the control network. Note: Whichever measure is on the 

left will be set to the Reference measure. Shortcut: P 

 Save Control Net: Save the current active control net. Shortcut: S 

 

2.7 Control Net Health Monitor 
 

The Health Monitor is a real-time representation of the state of a control network and statistics with respect 

to that health. The idea is that as changes are made to the control network real time feedback will be 

available through the health monitor. 

 

2.7.1 Overview Tab 

This tab holds the status, a description of that status, and a history table of modifications made to the 

network.  

 

The health of the control network is displayed at the top of the 

view there are three health modes currently. 

Healthy! – This indicates that there are no islands i.e. (no images 

that are not connected by control points) and all control points 

have 3 measures or more. 

Weak! – Will be displayed when there are no islands present but 

there are control points present containing less than three control 

measures. 

Broken! – Whenever islands are present broken will be 

displayed. 

Modification History – every change made to the control 

network will show up in this history. The tabs in the history are: 

Action, Id, Old Value, New Value, and Timestamp. 

 

2.7.2 Images Tab 

This tab displays information about images ( Figure 21). It 

contains a table of cube serial numbers in the network. 

 

The number of images with less than 3 valid measures is 

displayed. 

 

Note: convex hull tolerance has not yet been implemented. 

 

Double-clicking a cube serial number displays the associated 

image in the Cube DN View.  

 

 

 

 

 

 

 

 

 
Figure 20: Over view tab 

 
Figure 21: Image tab showing all images 

associated with the contol network. 
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2.7.3 Points Tab 

The points tab displays point specific information and includes a table that contains point information. 

 

The point distribution is shown in this view breaking them 

down by percent Figure 22. Next to each point type is what 

percent of the control network is composed of that point type. 

On the far right of the view is a view button that will display 

that particular point type in the table below. In the point table 

at the bottom points can be double clicked and it will pull up 

the control point editor. 

 

IGNORED POINTS DO NOT CONTRIBUTE TO THEIR 

POINT TYPE STAT. 

 

Points Table: Should display the filtered points (based on 

which view button is clicked) and if a point is double clicked, 

it should open that point in Control Point Editor. 

 
 

Figure 22: Points tab showing the overall 

breakdown of contol points. 



3 IMAGE MEASUREMENT 

 

User’s Manual  Page 3-5 

 

 IMAGE MEASUREMENT 
To be completed. 

3.1 Manual Measurement 
Describe the steps to make a manual measurement on a set of images  

3.1.1 Viewing and Adding Control Points 

In order to make manual measurements in images, an existing control network is needed as well as an image 

list.  

 

Ipce | import Control Networks | import Images 

 

Once the required data is imported it helps but is not mandatory to organize the views in the 

workspace so the Cube DN View and the Footprint View are both visible. Within each view the 

control point editor tool must be activated to begin measuring images. To do this click on the blue box with 

three white dots.  The setup should now look similar to Figure 23. Notice the red crosshair represents a 

control point and it can be seen in all the images it exists in as well as the footprint view. Once a control 

point is clicked in either Footprint or Cube DN view the Control Point Editor will be brought up and the 

point can be edited. 

 

 

 

 
Figure 23: Setup for adding and editing control point. 
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Creating a new control point 

Right clicking anywhere on the image 

or footprint view will create a point at 

that location and a dialog box will 

appear to select which images to 

include in the point Figure 24. Under 

point type there are three options free, 

constrained, fixed in order to select 

constrained or fixed a shape file must 

be imported. Once images are chosen the control point editor will pop up and the point can be edited with 

more detail. Once the point is saved in the control point editor it will then show in the Footprint and Cube 

DN Views.  

 

3.2 Editing Control Points 
Changing the exact location of a control measure can be done in the control point editor. By ensuring the 

control measures exist at the same geographical location in each image will make the control point more 

accurate.  

Within the Control Point Editor two measures can be viewed side by side this aids in making sure each 

measure does indeed lie at the same geographical location. The points are moved by either clicking a new 

location on the image or using the arrow keys seen in Figure 25. This process is further strengthened by 

selecting a control point at a distinct feature such as a crater in this example but it can also be anything that 

is easily distinguishable in all images. In Figure 26 it shows the red crosshair with a circle around it and the 

green + indicate control points. These are tools to aid in getting measures located accurately.  In the left 

image the red crosshair is at the location of the control point. In the right image the crosshair has been 

moved the right of the green control point. Notice save measures is in red this is because the red crosshair 

represents the location of the measure in that image and since it has been moved the option to save that new 

location is now available.  

 

Reference Measure 

 
Figure 24 Dialoge box for adding 

control point 

 
Figure 25: Contol Point Editor 
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The left image in the control point 

editor will be saved as the reference 

measure when save measures is 

clicked. This will be the reference for 

all the other images in the control 

point. If the reference measure is 

moved and then save measures is 

clicked a warning will occur to make 

sure the action is necessary since all 

other measures may need to be 

adjusted in result of the move. In order 

to change which image is the reference 

image the image must be viewed on the 

left side and then save measures 

clicked. Under left measure Reference: 

True will now be seen for that image.  

 

Control Point 

Point ID: The name or serial number of the control point 

Number of Measures: Number of measures in the control point 

Apriori Latitude: The unadjusted latitude 

Apriori Longitude: The unadjusted longitude 

Apriori Radius:  

Edit Locke Point: If this box it ticked … 

Ignore Point: If this box is ticked …  

Point Type: 

 Free…. 

 Constrained…. 

 Fixed …. 

Left/Right Measures 

Edit Lock Measure 

Ignore Measure 

Reference: (True/False) 

Measure Type: (RegisteredSubPixel, Manual) 

 

List of everything within Control Point Editor (From ISIS3 Astrogeology page with modifications for ipce) 

Other Point Editor Functions 

Along the right border of the window: 

 

 Geom: Geometrically match the right view to the left view 

 Rotate: Rotate the right view using either the dial or entering degrees 

 Show control points: Draw crosshairs at all control point locations visible within the view 

 Show crosshair: Show a red crosshair across the entire view 

 Circle: Draw circle which may help center measure on a crater 

Below the left view: 

 

 Blink controls: Blink the left and right view in the left view window using the "Blink Start" button 

(with play icon) and "Blink Stop" button (with stop icon). Both arrow keys above the right view 

and the keyboard arrow keys may be used to move the right view while blinking. 

 
Figure 26 Red crosshair and circle options 
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 Find: Center the right view so that the same latitude / longitude is under the crosshair as the left 

view. Shortcut: F 

Below the right view: 

 

 Register: Sub-pixel register the right view to the left view (Shortcut: R). This is where the 

Registrations templets comes in. At the top of Figure 25 there is a drop down to select Template 

file. This will default to $base/templates/autoreg/qnetReg.def but it can be changed to any of the 

imported Registration Templates.  

 Undo Registration: Undo the sub-pixel registration. Shortcut: U 

 Save Measures: Save the control measure under the left and right view to the edit control point. 

The image on the left will be set as (Reference: True) Shortcut: M 

 Blink: This will give the option to blink all images not just left and right.  

Along the bottom: 

 

 Save Point: Save the edit control point to the control network. Shortcut: P 

 Reload Point: This will reload to the last Save Point 

 Save Control Net: This saves the control network. This will have  

3.3 Automated Image Measurement 
To be completed. 
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 BUNDLE ADJUSTMENT 
To be completed. The process of photogrammetric control consists of two basic steps: image measurement 

followed by the least-squares bundle adjustment (Brown, 1958). The bundle adjustment improves image 

position and pointing parameters (together known as exterior orientation or EO) and generates the 

triangulated ground coordinates of tie and control points. Further, the bundle adjustment provides solution 

statistics and estimated parameter uncertainties. These statistics are another important justification of the 

control process, for without them it is impossible to compare products with any known level of confidence. 

The ISIS3 standalone bundle adjustment program is called jigsaw (Edmundson, et al., 2012). The bundle 

adjustment can be performed within IPCE as well.  

 

Jigsaw is currently capable of adjusting image data from frame and line scan cameras and the Chandrayaan-

1/LRO Mini-RF radar sensor. Although Magellan SAR and Cassini RADAR images can be processed in 

ISIS3, they are produced in map-projected form and are handled as maps rather than images. Currently, 

only Mini-RF radar images can be bundle adjusted (Kirk and Howington-Kraus, 2008). 

 

Using jigsaw, one may solve for sensor pointing alone, sensor position alone, or pointing and position 

simultaneously. Three dimensional coordinates (latitude, longitude, and radius) of all ground points are also 

determined in the adjustment. Through rigorous weighting, parameters may be held fixed, allowed to adjust 

freely, or constrained with a priori precision or accuracy information. 

4.1 Jigsaw Setup 

! NOTE: currently, all images in an IPCE project will be utilized in the bundle adjustment. So, for now, 

only images associated with the control network in the bundle should be in the project. 

 

To perform the bundle adjustment in IPCE requires a control network and associated images. Choosing 

Bundle Adjustment… from the Project menu displays the Jigsaw Setup dialog as a docked widget below 

the Project Tree Figure 27. Bundle settings are distributed among three (currently functional) tabs, General, 

Observation Solve Settings, and Target Body. 
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Figure 27Jigsaw docked widget 
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4.1.1 General 

Data  

Input Input network 

Output Adjusted network (can be renamed)  

Outlier Rejection Options Automatic rejection of outlier image measures 

Sigma Multiplier Will default to 3 when selected  

 Image measures are flagged as rejected if their residuals are 

greater than the multiplier times the current standard deviation 

(sigma) 

If 

Residuals > (multiplier * sigma)   

Then Rejected 

Maximum Likelihood Estimation  

Model Options HUBER - description 

 HUBER Modified – description  

 WELSCH – description 

 CHEN – description 

C Quantile Must be between Zero and One  

Convergence Criteria  

Sigma0 Threshold Standard deviation of unit weight 4.1.2 

Maximum Iterations Number of iterations program will stop at if not converged  

Global Apriori Point Sigmas 

(meters) 

 

Latitude  

Longitude  

Radius  

Other  

Observation Mode  

Error Propagation  
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Figure 28 
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4.1.3 Observation Solve Settings 

 

 

Instrument Position Solve Options  

SPK Solve Degree  

SPK Degree  

Solve Over Hermite Spline  

Instrument Pointing Solve Options  

CK Solve Degree  

CK Degree  

Twist  

Fit Polynomial Over Existing Pointing  

  

 

 
Figure 29 
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4.1.4 Target Body 

 

 

Target Need Info 

  

Target Parameters  

Pole Right Ascension  

Pole Right Ascension Velocity  

Pole Declination  

Pole Declination Velocity  

Prime Meridian Offset (wo)  

Spin Rate (WDot)  

  

Radii  

None  

Triaxial Radii  

Mean Radius  

  

 

 
Figure 30 
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4.2 Running Jigsaw 
Once the Jigsaw is open the only option will be setup 

Figure 31 Top. Jigsaw run dialoge Bottom. Abort 

option while jigsaw is running . Setup must be 

completed after the option to run will be available then 

once the bundle is complete the results can be accepted 

Figure 32 to and will add the data to the project tree 

under results. While the bundle adjustment is running 

the run button will change to an abort button this will 

stop the bundle at the current iteration and the results 

will not be available to accept. Selecting the write 

detached image labels will add and image list in the 

results with updated image labels. 

 

 

4.3 Output 

  

Figure 31 Top. Jigsaw run dialoge Bottom. Abort option 

while jigsaw is running 

 
Figure 32 Jigsaw widget after a bundle has ran 



 

5 EXAMPLE USE CASE DATA FLOWS 

 

User’s Manual   Page 5-1 

 

 EXAMPLE USE CASE DATA FLOWS 
 

5.1 Import Data; Bundle Adjust; Save, Close, and Reopen Project 
 

1. Start ipce by typing “ipce” on the command line 

2. Create project by … 

a. selecting "Save Project As" from File menu or 

b. "Save Project As" button on the toolbar. 

3. Import images. You can either multi-select Isis cube files or a list file containing a list of cubes.  

Important Note: Currently you will want to import all images you will be working on or running 

through the Bundle Adjustment in a single import. More flexibility will be available in a future 

version of ipce. 

a. Select “Import Images…” from the File menu or 

b. From the context menu on Project Tree.  Right-click on “Images” node, selecting “Import 

Images…”. 

c. Ipce creates ecub files (i.e. detached labels) which contain the cube labels and SPICE blobs 

and a pointer to the DN data or original cube file. You can choose to also import the DN 

data which will copy the original cube into the project folder. If you choose not to import 

the DN data, the ecub will have a pointer to the original cube. 

4. Import control net. 

a. Select “Import Control Networks…” from the File menu or 

b. From the context menu on the Project Tree. Right-click on the “Control Networks” node, 

choosing “Import Control Networks…”. 

5. If you have more than one control network imported, you will need to first set one of the imported 

control networks to the active control by right-clicking on the control network, selecting “Set 

Active Control Network”. 

6. Run jigsaw (Bundle Adjustment) 

a. Select “Bundle Adjustment…” from Project menu. 

b. Select appropriate settings for your data (Section 4.1). 

c. Select “Run” on Jigsaw dialog. 

d. Select “Accept”, then “Close” on Jigsaw dialog. 

i. There will be a new node on the Project tree under the Results node (Section 2.2.7) 

labeled with the date/time of the bundle run. 

7. Right-click on output control network selecting “Set Active Control Network”, then right-click 

again, selecting “View Network…”. 

a. You can then sort on Residual Magnitude under the Control Measure Table. If this control 

network is set as the active control network, editing from this view is enabled and can be 

done by right-clicking on any field in the tables and selecting “Edit selected control point” 

b. This will start the Control Point Edit View, which is similar in functionality to the qnet 

application. 

8. Correct any bad measures in the Control Point Edit View, saving the control network when finished. 

9. Re-run bundle adjust on the correct control network, making sure to select the previously bundle 

adjusted and manually adjusted control network in the Bundle Adjust setup dialog. 

a. Select “Bundle Adjustment” from the Project menu. 

b. Select correct control network on the “Input” option. 

c. Optionally, rename Output control network. 

d. Select “Ok” on setup dialog 

e. Select “Run” on Jigsaw dialog. 
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f. Select “Accept”, then “Close” on Jigsaw dialog. 

g. There will be a new node on the Project tree under the Results node (Section 2.2.7) labeled 

with the date/time of the bundle run. 

10. Other ways to see the active control network displayed and edit control points. 

a. Right-click on “import#” node of images on project tree (e.g. import1) and select “Display 

Images”. This brings up a view similar to the qview application with all of the qview tools. 

If a control net is imported the measures will automatically display when images are 

viewed. 

 

i. Click the “Control Point Editor” tool icon  to edit measures overlaid on the 

images. Mouse buttons operate the same as in the qnet application. 

1. Left click - edit closest control point 

2. Middle click - delete closest control point 

3. Right click - create new control point at cursor location 

b. Right-click on “import#” node of images on project tree (e.g. import1) and select “View 

Footprints”. This brings up a view similar to the qmos application with all of the qmos 

tools. 

i. Selecting the “Control Net” tool icon  to display points overlaid on the footprint 

view and to enable control point editing. Mouse buttons operated the same as in 

the qnet application. 

1. Left click - edit closest control point 

2. Middle click - delete closest control point 

3. Right click - create new control point at cursor location 

11. Save the project from the File menu or the “Save Project” button on the toolbar 

12. The saved project can be reopened by… 

a. Select “Open” from the File menu, browse to the desired project folder in the Select Project 

Directory dialog, select the project folder, click the Choose button. 

b. Or Select “Recent Projects” from the File menu and choose the corresponding project name 

from the popup menu. 

c. Or by typing from the command line > ipce projectName 
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 KNOWN ISSUES 

6.1  General Issues 
 

 Cubes must be Level1 (i.e. not projected) in order to import into IPCE. They must contain SPICE 

information (via spiceinit). If footprintinit has not been run on the cubes, a footprint will be created 

upon import (which can be time consuming). 

 All images in an IPCE project are currently utilized in the bundle adjustment. So for now, only 

images associated with the active control network should be in the project. 

 Images and control networks cannot be deleted from a project once imported. 

 Target body and sensors are not visible on the project tree after invoking File->Save Project As 

from the main menu to save the project. 

 The Spacecraft node of the project tree is empty for now. Sensor info appears in Sensors node. 

 When a project is closed, but IPCE remains open, the project name on the tree does not reset to the 

default name “Project.” 

 Closing cubes within the Footprint view cube list can cause crash. 

 Loading large image lists can take time (e.g. ~ 6 minutes for 1486 cubes). NOTE: It is highly 

recommended that you create and save a project before importing data. 

 Images in bundle results will not contain footprint information until the project is saved and closed. 

Re-opening the project will generate the footprint information. 

 It is recommended that bundle output control networks be named uniquely. Otherwise there may 

be some unpredictable behavior. 

 

6.2  Operating System and Window Manager Related Issues 

6.2.1 Linux 

6.2.1.1 KDE Window Manager 

 Under KDE, using "Focus Follows Mouse" under Window Management settings, detaching a 

view from the ipce main window causes the detached view to be hidden when ipce is not the 

active window.  This can be fixed with the following KDE setting: 

o Window Management->Window Behavior->Advanced tab->Uncheck "Hide utility 

windows for inactive applications" 
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